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Introduktion til digital pressefotografering

Kære kollega

Du skal nu til at omstille dig til at bruge et digitalt kamera i dit daglige arbejde. Kameraet
og måden at fotografere på adskiller sig ikke væsentligt fra det, du er vant til i øjeblikket.
Der er dog alligevel vigtige ting, du bliver nødt til at vænne dig til.

I denne brugerhåndbog forsøger jeg at komme ind på så mange af de praktiske aspekter
af digital fotografering som muligt.  Skulle der mangle svar på dine spørgsmål, er du
velkommen til at henvende dig til mig.

Nye og gamle dyder
De helt grundlæggende regler for digital fotografering ligner i virkeligheden gamle dyder fra
dengang pressefotografer arbejdede med farve-dias :

Eksponér rigtigt: Det digitale kamera kan spænde over fem blænder: Alle
overeksponerede dele af billedet forsvinder, alt undereksponeret ser hæsligt ud. Heldigvis
er der masser af hjælp at hente i kameraets indbyggede LCD-monitor og den
medfølgende flash. Bedste resultater opnås ved undereksponering på 1/3 til ½ blænde.

Beskær billedet i søgeren: Det digitale billede rummer kun af 1/3 den datamængde der
findes i en dårlig 400 ISO film.
Jo mere billedet senere, jo ringere bliver kvaliteten. Beskær derfor billedet hårdt i søgeren!

Brug så lav ISO som muligt: Billedkvaliteten er bedst på 200 ISO. Herefter falder
kvaliteten voldsomt. Væn dig til at bruge 200 ISO overalt!

Og så et par nye dyder:

Dygtiggør dig i Photoshop: Photoshop er dit nye mørkekammer, der rummer fantastisk
mange muligheder. Ikke mindst til at redde dårlige optagelser. Gør dig selv den tjeneste at
få det lært!

Sørg for frisk opladede batterier: Nikon D1 og Powerbook G3 bruger meget strøm.
Uden strøm er der intet, der virker. Sørg for at starte dagen med alle batterier ladet helt op.

God fornøjelse
Michael Bager

Denne 2. udgave indeholder små opdateringer samt flere nye tips og ideer. Desuden
behandles støjfiltrering med Band Aide og Quantum Mechanics Pro mere indgående. Set i
lyset af de mange Pc’er folk nu har stående hjemme, er denne udgave også blevet
Windows orienteret.
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Arbejdsgangen på Fyns Amts Avis

Nyt digitalt billedflow på Fyns Amts Avis
Fotoafdelingens overgang til digital fotografering skal ses i sammenhæng med, at hele
Fyns Amts Avis går over til et totalt digitalt billedsystem, der både omfatter billedets
bestilling, optagelse og arkivering.
I den forbindelse bliver noget af det arbejde, der i dag finder sted i repro og billedarkivet
enten automatiseret eller lagt i hænderne på journalister og pressefotografer.

Allerede ved bestillingen af fotoopgaven leveres noget af den information, der senere skal
bruges til at finde billedet frem igen. Fotobestillingen leverer også et identifikationsnummer
til billedarkiveringen.

Arbejdsgangen for fotograferne er derefter:

1. Billedet optages med Nikon D1. Som optageformat anbefales indtil videre JPEG fine.
Der gives ikke skarphed (Unsharp Mask) i kameraet. Billedet gemmes på kameraets
CompactFlash  kort.

2. Fotografen kan gennemse og udvælge billederne i programmet FotoStation 4 lite.

3. Fotografen færdigbehandler billederne i RGB farver i Adobe Photoshop 5:
Billedet gives en lav-radius Unsharp Mask
Billedet forsynes med caption i File Info.
Billedet forsynes evt. med et digitalt vandmærke
Billedet arkiveres som JPEG kvalitet 8 og overføres til Fyns Amts Avis billeddatabase
FotoStation via netværk eller over telefon.

4. FotoStation sammenfletter automatisk billedets File Info med informationerne fra
fotobestillingen. Fotografen og journalisten kan manuelt korrigere teksten.

5. Herefter foregår resten af billedbehandlingen i Color Factory, som er den automatiske
billedbehandler: Størrelsessætning, konvertering til CMYK eller S/H og Unsharp Mask.

Informationerne fra billedbestillingen, fotografens File Info og den billedtekst, der bliver
trykt i avisen, arkiveres sammen med RGB billedet.

På grundlag af disse informationer kan billedet, ved hjælp af søgefunktionerne i
FotoStation og FotoWeb, findes i billedarkivet.
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Nikon D1

I dette instruktionshæfte bruges de engelske begreber for kameraets dele, som de
anvendes i Nikons egen user’s manual side ii – iii.
Menu-valget på LCD-monitoren er ligeledes engelsk.
Begrebet CF henviser til Custom Functions dvs. personlige indstillinger, og må ikke
forveksles med CompactFlash kort.

LCD-Monitor
Bag på Nikon D1 sidder en 2” LCD monitor, som er den
digitale pressefotografs bedste ven. LCD monitoren
giver et ret godt indtryk af eksponering og farvestik.
Skarpheden kan derimod ikke vurderes. Monitoren bør
betragtes i en vinkel på 10-15° oppefra, hvilket føles
meget naturligt, når man står med kameraet i hånden
Til en mere præcis bedømmelse af eksponeringen kan
kameraet sættes til at vise et histogram og/eller
highlights.
LCD-monitorens lyshed kan justeres med sub-command hjulet når Mode-dial står på Play.

Det er muligt at spole lynhurtigt gennem alle optagelserne på LCD monitoren. Det sker ved
at tænde monitoren på Monitor knappen og holde Focus Area vælgeren nede i enten op
eller ned position i 4 sekunder.

Histogrammet ligner Levels fra Photoshop og viser fordelingen af tonerne i billedet. Ud ad
den vandrette akse vises lysheden (mørkest til venstre og lysest til højre). Ad den lodrette
akse vises antallet af pixels i en given lyshed.
Et jævnt eksponeret billede vil typisk have et histogram med et bjerglandskab, der fordeler
sig over hele koordinatsystemets bredde. Et undereksponeret billede vil have det meste af
landskabet i venstre side – et overeksponeret i højre side. Brug histogrammet som en
vejledning. At hele landskabet ligger i højre side gør ikke noget, hvis billedet viser to
isbjørne på en isflage.

Highlights funktionen får udbrændte højlys i billedet til at blinke. Det er ikke et problem,
hvis uvæsentlige dele af billedet, fx et vindue i baggrunden, brænder ud i højlysene. Men
hvis dele af et ansigt på et portræt begynder at blinke, så er det muligvis et problem.
Når Highlights funktionen er aktiv, kan visse billedinformationer, bl.a. tidspunkt, ikke vises
på LCD-monitoren ved at sideklikke focus area vælgeren.

Et lille fif; hvis du ofte ønsker at skifte mellem Histogram og Full-Frame billedvisning: Det
kan være ret besværligt at skifte via menuen på LCD monitoren (Mode-dial i Play > tryk L
> vælg Set Up >  Options > Histogram > Enter)
Via  CF nr. 27 i hhv. indstilling 2 og 3 kan der skiftes mellem hhv. Full-Frame og Histogram
(begge indstillinger er med Higlights aktiv).
Nu skal du blot trykke på CF mens du stadig er i fotograferings-mode og vælge 27-2 eller
27-3 med Sub-command hjulet. Tryk derefter to gange på Monitor knappen, eller vip en
gang op/ned med Focus area vælgeren.
Jeg har altid Highlights slået til, og tjekker jævnligt billedets histogram.
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Hvidbalance
Nikon D1 er udstyret med en hvidbalance funktion, fremover kaldet WB – White Balance.
Denne funktion, der kendes fra videokameraer, sørger for at ”filtrere” lyset, så hvide dele
af motivet også fremstår som hvide i billedet.
Kameraet har ud over seks faste WB funktioner, desuden en automatisk og en manuel,
alle har korrektionsmuligheder.

På LCD monitoren er det muligt at lave en god vurdering af WB. Den automatiske WB
fungerer ganske pålideligt, sålænge der fotograferes i dagslys. I kunstlysomgivelser,
særligt i glødelampelys, slår automatikken ikke til. I sådanne situationer plejer jeg altid at
stille WB til Incandescent.
Med den manuelle PRE WB kan hvidbalancen stilles meget præcist. Hvis der er tid til det,
bør du lave en PRE WB, når du fotograferer i kunstlys. Det sker ved at trykke WB ind og
dreje  Main-Command hjulet indtil PRE kommer frem i Rear Control panelet. Hold WB
knappen nede indtil PRE begynder at blinke. Fokusér og skyd  derefter ét billede af noget,
der er helt neutralt hvidt, fx et stykke papir eller en væg. For at kontrollere at
hvidbalanceringen er i orden, kan du tage et prøvebillede, hvis farvebalance du kan
vurdere på LCD-monitoren.
Husk at stille WB tilbage til A inden du begynder at fotografere i nye lysomgivelser.

I kunstlysomgivelser virker det i øvrigt, som om en korrekt WB giver dig en højere effektiv
ISO: I Gudmehallen kunne jeg eksempelvis tidligere i TV-lyset fotografere på 1/400s f/1.8
med en Fuji G-800 presset ½ blænde. Til sammenligning kan jeg med Nikon D1 nu
fotografere på 1/500s f/1.8 på 800 ISO.

Vær i øvrigt opmærksom på, at farvebalancen i mange lysstofrør ændrer sig 50 gange i
sekundet. Det hænger sammen med, at de tændes og slukkes med samme frekvens som
vekselstrømmen på elnettet. Når man fotograferer med lukkertider hurtigere end 1/50
sekund er det umuligt at få nøjagtig samme hvidbalance i alle billeder.
Glødelamper og specielle højfrekvente lysstofrøramaturer skifter ikke farve på samme
måde. Lyset i fx Gudmehallen er blandingslys med lysstofrør og glødelamper. Her er der
ingen forandringer i lyset.

Autofokus og billedfrekvens: I modsætning til Nikon F5 er det ikke muligt at indstille
Nikon D1 til udløserprioriteret autofokus. Det kommer i praksis til at betyde, at
billedfrekvensen er uregelmæssig og falder, når man følger et motiv i bevægelse. Det sker
typisk ved sportsfotografering. For at få fuld glæde af kameraets 4,5 billeder i sekundet
kan man slå autofokus helt fra. På AF-S objektiverne skal fokusvælgeren stå på M.

Objektiver
Den billeddannende CCD-chip i Nikon D1 er noget mindre end de 24x36 mm som er
negativformatet i filmkameraerne. Derfor sker der en beskæring af billederne, der opleves
som en forlængelse af objektivernes brændevidde.
Der sker dog ingen forandring hvad angår lysstyrke og dybdeskarphed, så selvom et 35
mm objektiv virker som et 52 mm, har den stadig samme store dybdeskarphed som et 35
mm. I praksis ganges brændevidden med en faktor 1,53.

Sammenligning af effektiv brændevidde ved 35 mm filmkamera og Nikon D1:



8

Brændevidde ved
35 mm film

Effektiv brænde-
vidde Nikon D1

Brændevidde ved
35 mm film

Effektiv brænde-
vidde Nikon D1

14 mm 21 mm 80-200 mm 112-306 mm

17-35 mm 26-52 mm 85 mm 130 mm

20 mm 31 mm 105 mm 161mm

24 mm 37 mm 135 mm 207 mm

28 mm 43 mm 280 mm 428 mm

50 mm 77 mm 300 mm 459 mm

60 mm 92 mm 420 mm 643 mm

Spøgelsesreflekser: Især når man fotograferer med 14mm objektivet, skal man være
opmærksom på reflekser fx fra vinduer, der ikke er synlige i søgeren på grund af
søgerbeskæringen.

Zoomglidning: Vær opmærksom på, at fokus kan flytte sig en smule, når brændevidden
på zoomobjektiver ændres. Dette skyldes muligvis et såkaldt anti-alias filter, der er anbragt
foran den billeddannende CCD-chip.
Derfor kan det være nødvendigt på ny at stille skarpt efter en stor ændring af
brændevidden. Det gamle trick med at zoome ind på motivet, stille skarpt og derefter
zoome ud igen kan ikke anbefales.

Billedformater
Nikon D1 kan gemme billeder i seks forskellige formater. Hvert format leverer billedfiler i
forskelige størrelser og kvaliteter.
Hvordan de forskellige formater vælges, kan du læse om i D1s User’s Manual side 28-29.
Det står naturligvis fotografen frit at vælge mellem formaterne.

Min anbefaling er, at du indtil videre anvender JPEG-Fine til hovedparten af opgaverne
og kan bruge RAW i specielle tilfælde.
Efterhånden som du får rutine i at arbejde med digital fotografering, vil jeg foreslå, at du
stille og roligt forsøger dig med RAW formatet.

Argumenterne for denne anbefaling bygger på følgende praktiske erfaringer:

JPEG: JPEG er et komprimeret fil-format. Det betyder, at kameraet ved hjælp af
matematiske beregninger reducerer billedets filstørrelse. Derved kan der gemmes flere
billeder på CompactFlash-kortet, overførslen af billeder sker hurtigere og billedet åbner
hurtigt på LCD-monitoren og i FotoStation.
Alt dette sker med et vist kvalitetstab. Med Fine kompressionen er der næsten ingen
synlige forandringer i billedet. Men billedet skal senere i billedbehandlingsprocessen
JPEG-komprimeres mindst en gang til. Her er der risiko for, at synlig JPEG støj optræder i
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billedet. JPEG-støj ses typisk som hakker omkring tynde mørke linier på lys baggrund, fx
udvendige husantenner eller grafik; og som misfarvninger i ellers ensfarvede flader.

Normal og Basic: Det er tydelig kvalitetsforskel på billeder optaget i JPEG-fine og JPEG-
normal. Af den grund kan det ikke anbefales at bruge JPEG-normal og basic. Skulle der
alligevel opstå situationer, hvor du er nødt til at anvende en af disse JPEG kvaliteter, bør
du efter billedbehandlingen gemme billedet i kvalitet 10 (Photoshop 5.0.2).

Fine: I JPEG-Fine komprimeres billedet 1:4, og kommer til at fylde mellem 0,9 og 1,3 MB.
Der kan således være ca. 120 - 160 JPEG-Fine billeder på ét 160 MB CompactFlash kort.

Brug af JPEG formatet forudsætter veleksponerede billeder. Som en del af
kompressionen, smides de billedoplysninger, der kunne have reddet en fejleksponering
eller et kraftigt farvestik bort. Når jeg bruger JPEG-Fine formatet tjekker jeg derfor jævnligt
min eksponering på LCD-Monitoren.
Erfaringsmæssigt kan fejleksponeringer indenfor –2 til +1 blænde ved 200/400 ISO uden
videre reddes i Photoshop.
Forsøg har vist, at det er muligt at lave billeder fra filer, der er undereksponeret 4 blænder
(v/ 200 ISO). Men kvaliteten bliver meget dårlig, da billedstøjen dominerer billedet. Ved to
blænders overeksponering får billederne et udtalt grønstik, og alle informationer i
højlysene forsvinder.

Hi – formaterne: RGB-TIFF og YcbCr-TIFF  formaterne kan ikke umiddelbart anbefales,
fordi de fylder forholdsvis meget og derfor er noget tungere at arbejde med end RAW og
JPEG. Der er ingen praktisk kvalitetsforskel på JPEG-Fine og de to TIFF formater.

RAW formatet er de ubehandlede data fra kameraets CCD. Formatet er ikke komprimeret,
og filen fylder ca. 4 MB. Det betyder, at der kan gemmes færre billeder på CompactFlash –
kortet, og at billedet åbner langsomt på LCD-Monitoren. I en Macintosh computer kan
formatet kun læses af Nikon Capture software eller MacBibble. PC-brugere kan desuden
se og behandle RAW filerne i  programmerne Qimage, Bibble og Cimage. Disse
programmer kan downloades fra Internettet. Se side 39.
RAW-billeder skal WB-korrigeres i computeren, idet kameraets WB ikke påvirker RAW-
billedet.

RAW-formatet giver lidt skarpere billeder end JPEG-Fine, og da formatet har 36-bit
farvedybde (mod JPEG og TIFF formaternes 24-bit) rummer det teoretisk set flere
eksponerings reserver.
Forsøg viser dog, at det er svært at se forskel på et korrekt eksponeret JPEG-Fine og
RAW billede ved 200/400 ISO. RAW er heller ikke et bedre udgangspunkt for at redde
fejleksponerede billeder, hvis man ikke er i stand til at betjene Nikon Capture.

Håndteringen af RAW billeder kræver erfaring med Nikon Capture eller andre RAW-
læsere, idet RAW billederne bliver lagret i Nikons eget .nef-format Det kan ikke åbnes i fx
Photoshop eller FotoStation.
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I Nikon Capture og MacBibble kan der foretages en simpel billedbehandling, hvorefter
billedet gemmes som en TIFF-fil, der siden kan behandles i Photoshop. I MacBibble kan
der desuden foretages en eksponeringskorrektion på billedet.

På grund af den lidt omstændelige håndtering af RAW-filerne, og fordi hver licens til Nikon
Capture koster over 3.000 kr., har Fyns Amts Avis valgt kun at anskaffe en licens, som er
installeret på fotoafdelingens fælles Macintosh G4.

B/W. Alle formater – på nær RAW - har en sort/hvid indstilling. Filstørrelsen er den
samme, som hvis billedet var optaget i farve i samme format. Pas på ikke utilsigtet at
optage billederne i S/H. Billedet kan ikke konverteres til farve. Læs mere om S/H billeder
på side 28.

Kameraet tildeler automatisk hvert billede et filnavn af typen DSC_0123.jpg. Når du bruger
flere kameraer, så sørg for, at der ikke optræder ens filnavne. Det giver en risiko for at det
ene af to enslydende billeder utilsigtet slettes!
Hvis du er ved at komme i den situation, kan du fx nulstille filnummereringen  i det ene
kamera. Det gøres i CF-29. Den står som standard på 1. Vælg 0, formater CompactFlash -
kortet (Dette vil slette alle billeder på kortet) og stil CF-29 tilbage til 1 igen. Nu genererer
dette kamera billedfiler fra DSC_0001.xxx

Custom – funktioner
Nikon D1 byder på stort set de samme CF-funktioner som Nikon F5. Dog er filmrelaterede
funtioner fjernet og der er tilføjet funktioner, der har med de digitale dele at gøre.
Se i øvrigt kameraets User’s Manual side 67 – 75.

En væsentlig forringelse i forhold til F5, er fravalget af F5’erens CF nr. 2-1, og dermed
muligheden for udløserprioritering i Single servo-AF.

En fornyelse er CF 9 og 10, der er hentet fra Nikon F100 kameraet. Funktionen får
kameraet til at stille skarpt på det nærmeste objekt, der er dækket af en AF-sensor. Smart
til klassisk Street-photography.

Standard indstillinger af Custom Functions: I det udleverede D1 samt i delekameraet
er der fra starten indstillet visse CF-funktioner, der ikke er fabriksstandard. På nær en
enkelt meget vigtig CF-indstilling, der kan have indflydelse på avisproduktionen, kan
fotografen frit vælge sine egne CF.
Detaljerne fremgår af det skema, der hænger ved delekameraerne, og som også er
vedlagt bagerst i dette hæfte.

Her følger en kort gennemgang af de væsentligste CF-indstillinger:

CF-4 fjerner i indstilling 1 AF-aktiverings funktionen fra shutter-release knappen. Der
fokuseres manuelt eller med AF-start knappen. I custom sæt A er CF-4 stillet til 0 i sæt B
er den stillet til 1.
CF-22 bestemmer, hvordan blænden betjenes. Som standard er valgt indstilling 0, som
gør det muligt at betjene blænden med Sub-command hjulet. I indstilling 1 betjenes
blænden på objektivets blændering.
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CF-23 giver kameraet mulighed for selv at give forskellige grader af UnsharpMask. Det
klarer vi selv senere i produktionen. Skal stå på 3 (dvs. ingen Unsharp Mask).

CF-24 er indstilling  af billedets tonekurve.
Dette har betydning for billedets
kontrastomfang.  Bør indtil fotografen opnår
tilstrækkelig erfaring stå på 0 (Auto). Se
afsnittet om kontrast kontrol herunder.

CF-27 styrer LCD monitorens visningsmode.
Se tippet sidst i afsnittet om LCD monitoren

CF-28 spærrer for muligheden for utilsigtet at
optage i RAW format. Indstilles på 1 hvis
RAW-optagelser tillades.

CF-29-1 får kameraet til at generere fortløbende filnumre til billedfilerne. På den måde
undgår man, at der optræder to ens filnumre på forskellige af samme dags optagelser
(Hvis man altså ikke skyder over 10.000 billeder om dagen). Se i øvrigt et trick under
Billedformater på side 10.

CF-31 hæver ISO følsomheden til 3200 ISO (indstilling HI-1) eller 6400 ISO (HI-2). Prisen
for den høje ISO er støj og dermed lav billedkvalitet. Læs afsnittet om ISO og digital støj
på side 13 inden du anvender denne indstilling.

Kontrast kontrol
I CF-24 kan man indstille kameraets tonekurve. Det har betydning for, hvordan kontrasten
i billedet bliver. Det er muligt at vælge mellem Normal kontrast (24-1); Lav kontrast (24-2);
Høj kontrast (24-3) og Automatisk (24-0). Desuden er det muligt at lægge en
brugerdefineret kurve ind (24-4).
Ved at skifte mellem de forskellige kurver, kan man således tilpasse ”filmens” kontrast til
motivets. Generelt kan 24-0 (automatisk) vælges til de fleste situationer. Jeg synes,
automatikken klarer det ganske godt. Dog kan det i hårdt lys og fx ved flashfotografering
være en fordel at skifte til lav kontrast (24-2). Dermed får billedet et større toneomfang, så
højlysene ikke så nemt brænder ud.
Jeg arbejder for det meste med indstillingen 24-2 (lav kontrast). Det giver ganske vist
nogle meget grå og kontrastløse billeder, når de åbnes i Photoshop. Men de kan meget
nemt rettes. Og jeg har aldrig problemer med udbrændte højlys.
CF 24-2 er et meget godt alternativ til at arbejde i RAW formatet.

Delekamera
Hver fotograf er udstyret med ét personligt Nikon D1. Derudover råder fotoafdelingen over
et D1 delekamera, som fotograferne kan disponere over i situationer, hvor det er
nødvendigt at medbringe flere kameraer. Kameraet er også et reservekamera. Derfor er
det vigtigt at give besked om, hvem der har kameraet.
Det er meget vigtigt at låneren af delekameraet stiller alle kameraets funktionerne tilbage
til standardindstilling efter endt brug, at CompactFlash kortet er formateret og at batteriet
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er ladet op. Det er den sidste låners ansvar, at delekameraet er helt i orden.
Standardindstillingen for delekameraet findes i appendix 3.

Flash
Digitalkameraer har generelt større vanskeligheder med korrekt flash eksponering end det
kendes fra Nikon F5 med C-41 film.
Så længe programautomatikken i Nikon D1 selv får lov at bestemme eksponeringen,
fungerer det imidlertid ganske pålideligt. Billederne har endda en tendens til at virke lidt for
vel udlyste, så jeg plejer at skrue lyset ned til –0.3 / –0.7.
I ekstreme modlyssituationer, fx når solen er med i biledet, er min erfaring, at lysstyrken
skal skrues op til +1.

Problemerne kommer, når der fotograferes på blændeåbninger større end 5 (v/ 200 ISO),
typisk i indendørs situationer, hvor man ønsker at få baggrunden velbelyst. Her kan
eksponeringen svinge meget. Jeg har selv vanskeligt ved præcist at styre eksponeringen.
Generelt plejer det at gå meget godt, når flashen skrues ned til -1.0 eller mindre, både i
direkte og indirekte; men jeg føler mig aldrig helt sikker på eksponeringen, før jeg har
tjekket den på LCD-monitoren. Nogle gange bliver billedet adskillige blænder
overeksponeret.
Det bedste råd i den situation er jævnligt at tjekke sine eksponeringer på LCD-monitoren,
og kompensere derefter.
Ved at vælge CF 24-2 ændres kameraets kontrastkurve til lav. Det giver erfaringsmæssigt
blødere flashbilleder og formindsker risikoen for udbrændte højlys.

AA-Flash: I stedet kan du bruge den nye AA flashautomatik. Det er en flashautomatik,
hvor lysmængden kontrolleres gennem et øje på selve flashen. Denne automatik er lige så
bekvem at arbejde med som TTL var det på F5’eren, idet den selv sørger for, at flashen
stiller blænden i overensstemmelse med det kameraet står på – både i hele, halve og
tredjedels trin. Desuden giver den mulighed for +/- korrektion (inden for visse rammer).
Til almindelig forefaldende flashfotografering som PF’ere udsættes for, virker AA ganske
pålideligt. Jeg vil dog som udgangspunkt anbefale følgende korrektioner:

Anbefalede flashkorrektion D1/SB-28DX ved AA-automatik

Udendørs direkte flash i
stærk modsol

+ 1

Alle indendørs/ tæt-på
situationer, både direkte
og indirekte

- 0.3 til –1

Direkte flash, lang
afstand/teleobjektiv

+ 0.3 til +1.3
evt. mere

Værdierne er med forbehold og med påsat Omnibounce
 – undtaget teleobjektiv/lang afstand

Tjek regelmæssigt dine flasheksponeringer på LCD-monitoren.

Filter-flash: Ved fill-in flash i kunstlys omgivelser kan følgende fif spare tid ved den senere
farvekorrektion i Photoshop:
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Montér et 85B filter foran flashen og stil kameraets WB på Incandencent (Glødelampe-
symbol). Flashen giver nu lys med omtrent samme farvetemperatur, ca. 3.300°K, som
omgivelserne. Begge farvestik ophæves af WB funktionen, og billedet fremstår
nogenlunde renfiltreret i Photoshop.
På samme måde kan monteringen af et CC10R og CC20G filter foran flashen kompensere
for det meste kunstlys. Se evt. kompensationstabellen i appendix 2.

Slaveflash: Det er ikke hensigtsmæssigt at bruge en slaveflash, når der fotograferes i
TTL-mode. Det skyldes, at SB-28DX udsender en lille præflash lige inden den egentlige
eksponering. Præflashen, der bruges til lysmåling, udløser slaveflashen, der så ikke er klar
til den egentlige eksponering. Du kan se præflash funktionen ved at tage et billede på en
længere lukkertid med flashmode i Rear (bagerste lukkergardin).

Løsningen på problemet er at stille SB-28DX på A-automatik. Hvis du bruger SB-26 som
slave, stil da slavefunktionen i D (Delay). Derved forsinkes SB-26’erens flashglimt i forhold
til SB-28DX’erens, så SB-28DX kan foretage en korrekt eksponering uden at blive
forstyrret af SB-26erens flashglimt.

ISO og digital støj
Lysfølsomheden i Nikon D1 kan indstilles mellem ISO 200 og 1600. Ved hjælp af CF-31
kan der desuden vælges ISO 3200 (HI-1) og 6400 (HI-2).

Kameraet laver helt klart de bedste resultater ved ISO 200. Ved ISO 800 og højere
optræder der synlig digital støj i billederne. Støjen, der er tydeligst i de mørke områder af
billedet, ses dels som blå og røde prikker, dels som striber på billedets længste led. Ved
ISO 3200 og 6400 er billedet meget medtaget af digital støj. Her kan støjen faktisk ses på
LCD-monitoren!

Støjen kan, efter mine erfaringer, forebygges og begrænses ved dels at sørge for en
korrekt hvidbalance – hvilket kan være svært i en sportshal på hurtige lukkertider. Dels ved
at lave en korrekt eksponering. Brug histogrammet i LCD-monitoren til dette formål.
Histogrammet bør gå fra kant til kant i koordinatsystemet.

Man kan forsøge at udnytte, at støjen er mest synlig i de mørke områder ved så vidt muligt
at undgå store mørke partier i de vigtige dele af billedet.
Billeder af håndboldspillere i lyse dragter i en lys hal bliver pænere end billeder af spillere i
mørke dragter på en mørk baggrund. Her kan man eventuelt overveje at anvende flash og
en lavere ISO.

Der findes endnu ikke et perfekt software på markedet, der kan fjerne den digitale støj.
Indtil videre er programmerne Quantum Mechanics PRO og Band Aide fra firmaet Camera
Bits de bedste bud på software til støjbekæmpelse. Fyns Amts Avis har indkøbt syv
licenser på disse programmer. Læs mere i afsnittet Fjern støj med Quantum Mechanics
Pro og Band Aide fra side 28.

Batterier
Nikon D1 er meget strømforbrugende, især når LCD monitoren anvendes. Et fuldt opladet
batteri kan lige nøjagtigt ikke klare en hel dags produktion.
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Det er derfor meget vigtigt at starte dagen med alle batterier ladet helt op.

Batteriet skal skiftes i god tid inden det løber helt tør. Kameraet vil advare dig ved at vise
”halvt batteri” i Top Control panelet. Hvis batteriet løber helt tør, mens et billede skrives til
CompactFlash-kortet, vil det pågældende billede gå tabt.

Hvis batteriet fjernes fra kameraet, mens dette er tændt, vil kameraet oprette en ny mappe
til billederne. Dette kan være ret forvirrende.

Batterierne bør jævligt genopfriskes. Se vejledningen, der følger med ladeapparatet.
Husk at gemme de små hvide plastichætter, der følger med batteriet. De kan sættes på
ekstrabatterierne, når de fx ligger i lommen. Hætten beskytter batteriets kontakter mod
snavs og utilsigtet kortslutning.

Kulde nedsætter batteriets ydelse. Derfor kan det være en god ide at have et ekstra batteri
liggende i en varm inderlomme.

Det er en fordel at bruge batterierne på skift. På den måde bliver de alle sammen holdt
ved lige, og man undgår den ubehagelige overraskelse, at ens sidste batteri er fladt.

Ryd hukommelsen: I panik situationer, hvor du ikke kan komme til at fotografere, fordi
kameraet skriver til CompactFlash kortet, kan du rydde hele bufferen ved kortvarigt at
fjerne batteriet. Bemærk, at alle billeder, der ikke er skrevet til kortet slettes uigenkaldeligt.
Desuden vil kameraet muligvis oprette en ny folder til de billeder, der optages efter dette
”buffer flush”. Det sidste er dog ikke et problem, det besværliggør blot håndteringen
bagefter.

Rens af CCD:
Støv på CCD chippen resulterer i sorte pletter på billedet. Du kan se direkte ind på
CCD’en (eller rettere det filter, der dækker den) ved at eksponere på ”Bulb” og holde
udløserknappen nede.

Jeg har tidligere anbefalet, at støv på CCD-chippen i Nikon D1 kun må fjernes med de
gummiblæsere, I har fået udleveret.
Efter at jeg har talt med Tore Østvedt, der er tekniker hos fra Nikons danske importør, kan
følgende to andre metoder også benyttes. Men det skal ske med stor forsigtighed, på eget
ansvar og kun som beskrevet her:

Støvfjerning med trykluft: Der må kun anvendes trykluft på dåse, som den Dust-Off, jeg
har indkøbt. Der må ikke bruges luft fra en kompressor, da trykluften herfra ofte indeholder
vand.

1: Montér det røde blæserør på trykluftdåsens ventilhovede. Hold dåsen helt lodret og pust
en enkelt gang væk fra kameraet. På den måde renses ventilen og blæserøret for
kondensvand og støv.

2: Skab adgang til CCD'en ved at stille kameraet på "Bulb" og holde udløserknappen
nede.
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3: Blæs fra en afstand af ca. 15 cm direkte på midten af CCD'en. Inden i kameraet findes
små klæbepuder, der opfanger den støv, trykluften hvirvler op.

4: Fjern blæserøret fra kameraet og slip eksponeringsknappen. CCD'en skulle nu være
renset.

Pletfjerning med Isopropanol
1: Fjern først støv fra CCD'en som beskrevet ovenover.

2: Tag et stykke nyt rent linsepapir og vikkel det om spidsen på en vatpind. Dyp vatpinden
let i Isopropanol.

3: Skab adgang til CCD'en ved at stille kameraet på "Bulb" og holde udløserknappen
nede.

4: Gnid forsigtigt pletten væk. Der må ikke lægges kræfter i.

5: Fjern vatpinden fra kameraet og slip eksponeringsknappen. CCD'en skulle nu være
renset. Forsvinder pletten ikke, skal kameraet sendes til rensning på værkstedet.

Bemærk at trykluften og Isopropanolen er meget brændbar.

Det er ikke hensigtsmæssigt at fjerne støv fra CCD'en ved at puste det væk med munden.
Der er stor risiko for, at mundvand og pibesovs følger med og gør tingene meget værre.

Støv på CCD'en kan tildels forebygges ved at :

- Vende kameraets objektivfatning nedad, når der skiftes objektiv.
- Holde objektivernes bagerste linseelement fri for støv. Sørg for altid at have dæksel på,
når objektivet ikke bruges.
- Holde kameratasken ren.
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Computer

Windows PC og Macintosh
Denne brugerhåndbog tager oprindeligt udgangspunkt i Apple Macintosh computeren. På
baggrund af det stigende antal hjemme PC'er, som folk anskaffer sig for tiden, har jeg
opdateret denne udgave med PC-genveje og et PC-transmissionsprogram til FTP.

PC handlinger og genveje fremhævet med kursiv. Hvor der står fx ”Genvej zZ PC: Ctrl Z”,
er zZ Mac genvejen og Ctrl Z er PC genvejen.
Hvis genvejen til Mac og PC er den samme, fx i mange Photoshop genveje, vil der fx blot
stå ” Genvej: Y”

Kortlæser til PC: Den fleste nye PC'ere er udstyret med en USB-port. Det gør det muligt
at tilslutte den Lexar-kortlæser ”Jump-Shot”, der følger med CompactFlash-kortene.
Efter installation af Lexar-softwaren og tilslutning af Jump-Shot kan CompactFlash kortet
nu læses af PC’eren.
CompactFlash- kortet kan fjernes fra kortlæseren, så snart læsningen er ophørt uden at
skulle ”smide det i skraldespanden”.
Detaljer omkring filoversættelse er forklaret i appendix 2 på side 41 .

Apple PowerBook G3
I opsætningen af fotografens personlige bærbare Powerbook G3 er der lagt vægt på
enkelhed, brugervenlighed og stabilitet. Alle relevante programmer kan således
startes fra Kvikstart.
Hvis kvikstart ikke findes på skrivebordet, kan det hentes i Æblemenu >
Kontrolpaneler > Kvikstart.

Håndtering af CompactFlash-kort
CompactFlash kortet indsættes i den bærbare computer ved hjælp af en adapter. Kortet
kan kun sættes i på én måde.
Kortet og adapteren sættes derefter ind i den tændte computers PC-
kortlæser i venstre side.
Et øjeblik efter dukker symbolet ”Nikon D1” op på skrivebordet.

I en PC tilsluttes Jump Shot til PC’ens USB-port. CompactFlash kortet indsættes i
læseren, og et øjeblik efter dukker et ”Nikon D1” ikon op på skrivebordet. Det kan se
anderledes ud end det, der er vist herover.
Kommer ikonet ikke frem på skrivebordet, kan det sandsynligvis findes ved at
dobbeltklikke på ”Denne Computer” ikonet. Her findes Nikon D1 ikonet sandsynligvis
sammen med ikonet for A: drevet og C: drevet.
 Ikonet kan trækkes ud på skrivebordet, så der er nemmere adgang til kortlæseren en
anden gang.

Inden du foretager dig yderligere, bør du oprette en ny mappe på skrivebordet. Dette
gøres på en Macintosh ved at klikke et tomt sted på skrivebordet, mens Ctrl-tasten holdes
nede, vælg ”Ny mappe” (Genvej zN)
PC: Højreklik med musen på skrivebordet. Vælg Ny > mappe.
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Dobbeltklik derefter på Nikon D1 ikonet > DCIM > 10XNC_D1.
Markér alle billedfil ikonerne (Genvej: zA PC: Ctrl A) og træk dem hen over den netop
oprettede mappe. Nu kopieres alle billederne fra kortet til harddisken på den bærbare
computer.

Herover: Tv. JPEG fil fra en PC, th. JPEG fil fra en Macintosh computer

Inden CompactFlash kortet fjernes fra en Apple Macintosh computer, er det meget vigtigt,
at kort-ikonet trækkes i skraldespanden (Genvej zY). CompactFlash kort mm. skal altid
afsluttes på denne måde. Ellers risikerer man at ødelægge kortet. Fjern
derefter kortet med adapter ved at trykke den lille pind ved den bærbare
computers PC-kortlæser ind.
Husk altid at tjekke, at alle dine billeder rent faktisk er kopieret til
computeren, inden du sletter eller formaterer dit CompactFlash kort.

Hvis billedfilerne på CompactFlash kortet trækkes direkte ud på skrivebordet i en Apple
Macintosh computer, og ikke bliver lagt tilbage på kortet, inden det fjernes fra computeren,
skal kortet formateres i kameraet, inden der igen kan fotograferes med det. Ellers får du
meldingen ”The card containes no image files” når du kontrollerer dine billeder på LCD-
monitoren. Se afsnittet ”Løsninger på kendte problemer” i appendix 2.

Monitor betragtningsvinkel
Lysheden på monitoren på den bærbare computer varierer meget afhængigt af
betragtningsvinklen. Det kan godt gøre det vanskeligt at lave en god billedbehandling.
Skrivebordsbaggrunden, som jeg har fået lov til at stjæle fra Nordjyske Stiftstidende, kan
give lidt hjælp til at finde en ensartet betragtningsvinkel.
Men billedbehandling på den bærbare computers LCD-monitoren vil altid være  en
nødløsning. Det er meget vanskeligt at bedømme billedernes farve, skarphed og kontrast.
Professionel billedbehandling bør ske på en skærm med billedrør.
Den bærbare computer kan nemt tilsluttes enhver nyere computerskærm.

Tilslutning af 21” monitor
Fotoafdelingens to løse 21” Apple ColorSync monitorer kan tilsluttes den bærbare
computer med et monitorkabel og et USB kabel. Derved bliver det USB udstyr, der er
forbundet til monitoren, også forbundet til den bærbare computer. Det er mus, tastatur,
CF-kortlæser, CD-ROM brænder og Epson printer.

Tilslutning til FAAs netværk
Når en Apple computer har været afbrudt fra netværket i tændt tilstand, skal den muligvis
have hjælp til at blive tilsluttet igen. Dette kan ofte gøres ved at:
Kontrollér, at netværkskablet er korrekt forbundet.
Vælg Æblemenu > Seneste fællesarkiver > Produktion (eller den server man nu ønsker at
tilslutte.)
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Findes den ønskede server ikke dér, kan den findes i Vælger > AppleShare > NT1. Sørg
for, at Appletalk er aktiv. det kan du kontrollere nederst i Vælger

Tilslutning til Internettet
Internettet anvendes til transmission af fotografernes billeder, når han ikke har adgang til
Fyns Amts Avis netværk. Desuden kan de billedbestillinger, fotografen selv laver for at
kunne arkivere initiativbilleder, kun oprettes via Internet fra Fyns Amts Avis’ interne
netværk i Sct. Nicolai Gade.

Den bærbare Macintosh computer kan konfigureres på tre forskellige måder, afhængigt af
om der skal skabes internetforbindelse via Fyns Amts Avis’ interne netværk, via
fastnettelefon eller via GSM telefon.

Arbejdet med konfigureringen er søgt forenklet, så det er den samme ensartede – men
omstændelige –  arbejdsgang hver gang, der skal skiftes konfiguration. Se den detaljerede
beskrivelse i appendix 5 på side 46.
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Billedbehandling

Billedudvælgelse med Fotostation 4.0 lite (build 85)
Fyns Amts Avis har valgt FotoStation 4.0 udelukkende som billedbrowser til
fotograferne. FotoStation 4.0 har også visse simple billedbehandlingsfunktioner
og muligheden for at tilføje tekst til billederne.
Desuden er det muligt at se visse optagedata fra kameraet. Billedets filnummer

samt tid og dato for optagelsen vises i FotoStations åbningsbillede. Tast zi (PC: Alt Enter)
for at se et markeret billedes øvrige eksponeringsdata, som fx lukkertider og brændvidde.

Her et forslag til en rationel måde at se billederne og behandle dem på:

• Forbered billedbehandlingen
• Først åbnes alle billederne på CompactFlash kortet i billedbrowseren FotoStation 4,

hvor alle billederne bekvemt kan overskues.
• Herfra udvælges de billeder, der ønskes behandlet og arkiveret.
• De udvalgte billeder åbnes i Photoshop, behandles og gemmes derpå i

billedarkivsystemet, som også er FotoStation.

1. Forberedelse: Opret en tom mappe på skrivebordet. Det gøres ved at klikke et tomt
sted på skrivebordet, mens Ctrl-tasten holdes nede, vælg ”Ny mappe” (Genvej zN)
PC: Højreklik med musen et sted på skrivebordet > Ny > Mappe
Kald fx mappen for dags dato, altså fx 19991215. Sørg for, at den grønne (PC: gule)
”Udvalg” mappe på skrivebordet er tom.

2. Kopiér billedfilerne: Kopiér derefter alle billedfilerne fra CompactFlash kortet til netop
oprettede mappe: Dobbeltklik på Nikon D1 ikonet > DCIM > 10XNC_D1. Markér alle
billedfil ikonerne (Genvej: zA PC: Ctrl A) og træk dem hen over den netop oprettede
mappe.
Alle billedfilerne fra CompactFlash kortet kopieres nu til mappen. Herefter kan
CompactFlash kortet fjernes fra computeren. Dette gøres ved at trække Nikon D1
ikonet ned over skraldespanden (Genvej: Markér ikon, zY). PC: Fjern blot kortet fra
kortlæseren når læsningen er afsluttet.

3. Gennemse billederne: Åben FotoStation 4.0 fra Kvikstart. Klik på Browser mappen og
vælg den netop oprettede mappe på skrivebordet. Svar Nej i dialogboksen.
Herefter åbnes alle billederne fra CompactFlash kortet sig som thumbnails: Antallet og
dermed størrelsen af thumbnails kan vælges i det lille hvide felt øverst til højre i
skærmbilledet. 4x2 vil eksempelvis vise 8 billeder ad gangen.

4. Flyt billederne: Marker de billeder, der skal viderebehandles og træk dem over i den
grønne Udvalg mappe, som findes under Browser mappen i skærmbilledets venstre
side. Disse billeder flyttes automatisk til den grønne (PC: Gule) Udvalg mappe på
skrivebordet.

Hvis du har brug for at se et billede i stor størrelse kan du dobbeltklikke på det. (PC:
tast Retur).
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Det er muligt at trække flere billeder over på én gang. Hold Shift tasten nede hver gang
du vælger et billede. Hvis du fortryder et valg, trykker du blot en ekstra gang på billedet
(husk stadig at holde Shift tasten nede) og billedet vælges fra igen. Træk alle de valgte
over i den grønne Udvalg mappe som ovenfor beskrevet.

5. Billedbehandling: Når alle de billeder, du ønsker at viderebehandle, er flyttet til den
grønne Udvalg mappe, kan du lukke FotoStation (genvej zQ Ingen PC genvej).

Åben nu den grønne (PC: Gule) Udvalg mappe på skrivebordet og markér indholdet
(Genvej zA PC: Ctrl A). Træk filerne hen over Photoshop 5-ikonet i Kvikstart (PC:
ikonet findes på skrivebordet). Herefter åbner alle de udvalgte billeder sig i Photoshop.
Det kan godt tage sin tid, hvis du har mange billeder. Det kan være hensigtsmæssigt
kun at åbne ca.10 billeder ad gangen.

Selve billedbehandlingen beskrives indgående i næste afsnit.

6. Efter endt billedbehandling kan Photoshop lukkes. De behandlede billeder ligger nu
som ikoner på skrivebordet. Disse flyttes på gammeldags manér til henvisningsmappen
FAA-Fotografer (forudsætter at du er koblet til Avisens netværk. Er du ikke det, så læs
afsnittet om transmission, som starter nederst på denne side. Overføres billeder fra en
lokalredaktion læs da side 47).

De behandlede billeder på skrivebordet og deres ubehandlede originalfiler, som stadig
ligger i den grønne Udvalg (PC: gule) mappe, kan fx gemmes i fotografens eget arkiv.

Egenarkivering
Du kan nu gemme alle de udvalgte billeder, både de behandlede og ubehandlede, i dit
eget arkiv.
Jeg gemmer alle mine billedfiler. I en mappe, jeg kalder Dagens Udvalg, placerer jeg de
behandlede og ubehandlede versioner af dagens udvalgte billeder. Den mappe anbringes
inden i dags dato-mappen, hvor samtlige dagens eksponeringer findes.

For overskuelighedens skyld gør jeg det, at jeg opretter en mappe for hver uge, fx kaldet
”Uge 52 1999”, hvori jeg lægger de daglige mapper fra denne uge. Ugemappen placerer
jeg dels på Produktionsserver > Browser > Nikon > MB og på min egen harddisk. En gang
om ugen brænder jeg så en CD-ROM med ugens produktion. Det plejer at kunne ligge på
én CD-ROM.
Selve den praktiske brænding af CD-ROM gennemgås i ”Sådan brænder du din egen CD”
i Arkiverings-afsnittet på side 35.

Husk at tømme Udvalg mappe, så den er klar til næste dags udvalg.

Transmission
Når fotografen ikke har direkte adgang til Avisens netværk, kan billederne overføres via
telefon.
Dette sker ved at oprette forbindelse til Internettet og via en FTP-klient at oploade
billederne til Fyns Amts Avis FTP-server. Avisens billeddatabase henter derefter billederne
fra FTP-serveren.
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Hvis FTP ikke virker, kan billedet sendes i en email som vedhæftet fil. Det kræver, at der
er nogen til stede i bladhuset til at åbne emailen og overføre billedet til Fyns Amts Avis
billeddatabase.

Transmission fra Macintosh
Internetadgangen skal  indstilles forskelligt, afhængigt af om du kalder op via en
fastnettelefon eller GSM. Se instruktionen i appendix 5.

Almindelig telefon: Konfigurér computeren til at forbinde til Internet via alm. telefon.
Tilslut powerbooken til telefonstikket og tryk på enten Netscape eller Fetch ikonet i
Kvikstart. Herefter forbindes du til Internettet med en højeste hastighed på 57kbps.

Hvis du ringer ud via et omstillingsbord, hvor der
skal tastes 0 for at få en linie ud, kan du i selv tilføje
et 0,  (nul komma) foran det telefonnummer, der
fremkommer i dialogvinduet Remote Access til sidst
i konfigurations processen.
Kontrollér for en sikkerheds skyld, at
telefonsystemet er analogt. Det indbyggede modem
i den bærbare computer kan ikke anvendes sammen
med et digitalt telefonanlæg. Der er risiko for, at
computeren brænder af, hvis den tilsluttes et digitalt
telefonanlæg!

Standard telefonnummeret er Tele Danmarks
opkoblingspunkt i Svendborg. Hvis du befinder dig
udenfor Svendborg, kan det være en fordel at ringe
til et lokalt opkoblingspunkt. Telefonnummeret
ændres ud fra den liste, der findes i appendix 5.

GSM: Konfigurér computeren til at forbinde til Internet via mobiltelefon.
Aktivér Infrarød på din GSM telefon og placer den, så telefonens infrarøde port kan se
Powerbookens infrarøde port. Den findes på bagsiden af Powerbooken i modsatte side af
stikket til strømforsyningen. Tryk på Netscape, Internet Explorer eller Fetch ikonet i
Kvikstart. Herefter forbindes du til Internettet med en højeste hastighed på 9,6 kbps.
Hastigheden vil ofte være lavere, og en billedoverførsel tager gerne mere end fem
minutter.

Antennesignal viseren på GSM-telefonen fortæller kun hvor godt GSM Telefonen
modtager signaler fra sendemasten. Ikke hvor godt dine signaler bliver modtaget.
Til begivenheder hvor mange mennesker er samlet, vil der ofte være en stor belastning af
GSM-nettet. I sådanne situationer kan det være umuligt at få etableret en forbindelse.
Det hænger bl.a. sammen med, at dataopkald har en lavere prioritet end samtaleopkald.
(SMS-opkald har i øvrigt højeste prioritet, så man kan altid få en SMS igennem).
I sådanne situationer må man enten fjerne sig så langt fra de snakkende
menneskemasser, at man kan få forbindelse via en anden GSM sendemast eller låne sig
frem til en fastnetforbindelse, hvis det er muligt.
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Forvent altid problemer ved store begivenheder og tag højde for dem på forhånd.

Fetch  er en såkaldt FTP-klient File Transfer Protocol til Macintosh.

Fetch åbnes ved at trykke på Fetch ikonet i Kvikstart. I New Connection
vinduet, herunder til venstre, trykkes OK. Når forbindelsen er etableret, trækker
du dine billedfiler fra skrivebordet ind i det store hvide felt i venstre side af

foto.faa.dk vinduet herover til højre.

Herefter viser et ur, hvor meget data der er overført. Overførslen er ikke
afsluttet, før uret forsvinder og billedets filnavn dukker op i det hvide felt i
foto.faa.dk vinduet. Hvis forbindelsen afbrydes inden uret forsvinder, er
transmissionen ikke lykkedes.
Overførsel via GSM kan tage op til 15 minutter pr. billede. Ofte står uret stille i længere tid
ad gangen. Det kan godt være en nervepirrende oplevelse lige op til deadline…

Bemærk i øvrigt, at der går yderligere ca. fem minutter fra billedet er overført til det rent
faktisk kommer endeligt ind i Fyns Amts Avis billedsystem.

Hvis det er nødvendigt, at billedet skal hurtigt afsted, kan der vælges en hårdere jpeg
kompression, når billedet gemmes i Photoshop. Læs mere på side 26 i afsnittet Adobe
Photoshop 5.0.2. Kompression udover de anbefalede 8, reducerer billedkvaliteten synligt.
Men det kan blive et spørgsmål om at få et billede af dårlig kvalitet i avisen, frem for slet
intet.

Transmission fra PC
Crystal FTP 2000 er en såkaldt FTP-klient File Transfer Protocol til Windows.
Programmet er gratis, så man må finde sig i, at der er bannerannoncer på.
Inden du begynder på transmissionen, kan du lægge de billeder, der skal
sendes, i en mappe på skrivebordet. Kald fx mappen ”Transport”.
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Crystal FTP åbnes ved at dobbeltklikke på ikonet på skrivebordet.  ”Transport” mappen
findes fx ved at klikke på det lille mappe-med-lup ikon omtrent midt i skærm-
billedet. Når mappen er valgt, fremkommer de billedfiler, det er muligt at
transmittere, i det store vindue i venstre side af skærmbilledet. I eksemplet herunder er der
fire billedfiler.

Forbindelsen til Fyns Amts Avis FTP server etableres nu ved at klikke med musen på
”Connect” feltet i øverste venstre side af vinduet herover.

Når forbindelsen er etableret, trækkes billedikonerne fra venstre vindue til højre vindue,
som den grønne pil herover illustrerer. Herefter starter transmissionen.
En procesbjælke i bunden af vinduet viser, hvordan transmissionen skrider frem. Når
billederne er transmitteret trykkes på ”Disconnect” for at afbryde Internetforbindelsen.

Næste gang programmet Crystal FTP startes, åbnes den mappe, du sidst sendte fra
automatisk. I dette tilfælde vil det være Transport-mappen.

Adobe Photoshop 5.0.2
Når man begynder på billedbehandling i farver kan det føles ret uoverskueligt at
behandle 10 - 20 farvebilleder hver eftermiddag. Min erfaring er dog, at det
hurtigt bliver rutinearbejde.
Fotografer, der gør sig ekstra umage med lyset og eksponeringen i optagelsen,

vil få det væsentligt nemmere, når billedet senere behandles i Photoshop.
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Generelt kan man sige, at elektronisk billedbehandling foregår ved at smide billed-data
væk: Hver gang der ændres i Curves eller Levels, eller hvad alle disse værktøjer hedder,
bliver der mindre tilbage af det oprindelige billede. Derfor er det vigtigt at anvende så få
værktøjer som muligt. Og gerne så lidt som muligt. På den måde sikres den bedst mulige
billedkvalitet.

Simpel billedbehandling i Photoshop 5
For at forenkle billedbehandlingen er Photoshop i din bærbare computer sat op med et
forslag til hvordan og i hvilken rækkefølge, du behandler billedet. Jeg vil foreslå, at du først
går videre med mere avanceret billedbehandling, når du er blevet fortrolig med den simple.
I løbet af året vil jeg tilbyde små fyraftenskurser med tips og tricks.

Actions
I Photoshop 5 på din bærbare Powerbook er der
indlagt såkaldte Actions, (Window > Show Actions),
der får Photoshop til at foretage små for-
programmerede handlinger, fx at give en bestemt
mængde Unsharp Mask.

Hver fotografs powerbook er udstyret med individuelle
Actions. Actions er nummereret i den rækkefølge, jeg
vil foreslå, at du behandler billedet i.

Du kan selv ændre dine Actions eller lave nye. Læs
mere om det sidst i dette afsint.

1: Rotér billedet:
Hvis det er nødvendigt, bør du starte med at vende
billedet rigtigt.
Action 1a Rotér 90° CCW (Counter-Clock-Wise = mod
uret).
Action 1b Rotér 90° CW (Clock-wise = med uret).

Beskær billedet: Hvis det er nødvendigt at beskære billedet, kan det med fordel gøres
tidligt i processen. Derved gøres datamængden mindre, og billedet bliver hurtigere at
arbejde med.
Vælg Crop-værktøjet (Genvej: C) øverst tv. i værktøjskassen. Træk med cursoren ned
over billedet og flyt evt. hjørnerne på værktøjet, så det passer med din beskæring.
Dobbeltklik (Genvej: Retur-tasten) inde i det afmærkede felt, og billedet er nu beskåret.

2: Levels: Action 2 åbner Levels (Genvej: zL PC: Ctrl L). Her kan du justere billedets
lyshed og kontrast. Tænk ikke på farverne endnu! Lasso-værktøjet (Genvej: L) kan
anvendes til en partiel justering, så fx tegningen i himlen ikke forsvinder, selvom resten af
billedet lysnes.

3: Curves: Action 3 åbner Curves (Genvej: zM PC: Ctrl M). Curves er velegnet til at
korrigere mellemtonerne i billedet, men kan bruges til praktisk taget alle justeringer af
kontrast, lyshed og farvestik.
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Hvis der i billedet findes et sted, der skal være helt neutralt hvidt, kan den hvide pipette i
Curves kan bruges til at sætte hvidbalancen. Lasso-værktøjet (Genvej: L) kan anvendes til
en partiel justering fx til at lysne et ansigt.

4: Hue/Saturation: Action 4 åbner
Hue/Saturation (Genvej: zU PC: Ctrl U), der
betyder noget i retning af Farve/Mætning. Her
kan et generende farvestik fjernes. Lasso-
værktøjet (Genvej: L) kan anvendes til at rette
op på et partielt farvestik, fx røde ansigter.
Vælg den farve, du ønsker at ændre.
Hue ændrer farven det angivne antal grader
på farvecirklen. En Hue på +90 vil fx ændre
rød til grøn.
Ved at forskyde Saturation knappen
svækkes eller forstærkes netop den valgte
farve.
Lightness ændrer mængden af sort i farven.

Rødstik er et generelt problem ved digital fotografering. Det findes typisk i et ansigt og kan
let fjernes med Hue/Saturation: Afgræns ansigtet med lasso-værktøjet, åben
Hue/Saturation og indstil Edit til Red (genvej z1 PC: Ctrl 1). Sæt fx værdien i Saturation til
minus 5 og i Lightness til plus 5.

5: Quantum Mechanics Pro og Band Aide fjerner den digitale støj i undereksponerede
og høj-ISO billeder. Disse to filtre kan gives enkeltvis eller i kombination, afhængigt af
hvilken type støj, der findes i billedet. Quantum Mechanics Pro fjerner crominans støj (blå
og røde prikker) Band Aide fjerner den såkaldte Banding, stribeformet støj. Læs mere om
de to filtre i afsnittet Avanceret Photoshop 5.0.
De to filtre må ikke gives efter at Unsharp Mask er givet.

6: Unsharp Mask: Action 6 a-c giver automatisk en Unsharp Mask i billedets luminans
lag. Det er vigtigt ikke at give for meget skarphed. Den egentlige skarphedsgivning foregår
nemlig senere i den automatiske billedbehandler, efter at billedet er blevet størrelsessat.
Formålet med det er at tilpasse skarpheden til den størrelse, billedet får i avisen.

Husk, at skarpheden kun kan vurderes, hvis billedet betragtes i mindst 100% forstørrelse.
Dobbeltklik på lup-ikonet i værktøjskassen for at få billedet i 100%.
Dobbeltklik på hånden for at se billedet så stort, som skærmen tillader.

Action 6a giver en minimal mængde Unsharp Mask. Formålet er at fjerne den uskarphed,
som Anti-Alias filteret foran kameraets CCD giver. Denne Action gives til helt skarpe
billeder.
Action 6b giver lidt mere Unsharp Mask til fx vidvinkel billeder eller billeder, der er en lille
smule ude af fokus.
Action 6c Ude af fokus Hvis dit billede er optaget ude af fokus, kan denne Action give så
meget Unsharp Mask, at det muligvis reddes. Vær dog kritisk overfor billedets udseende.
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Lasso-værktøjet (Genvej: L) kan anvendes til partielt Unsharp Mask, fx hvor en generende
baggrund ikke ønskes skarp .

7: File Info: Denne action åbner File Info og skriver automatisk dit navn i Byline og
Caption Writer-felterne. Desuden tilføjes copyright informationer. Cursoren står klar i
caption-feltet, hvor du skriver din billedtekst.

8: Digimarc + Save as: Til sidst kan du med Action 7 forsyne dit billede med et digitalt
vandmærke. Herved bliver der lagt en kode ind i billedet, der ikke kan ses med det blotte
øje, men genkendes af firmaet Digimarcs software.

Efter Digimarc filteret er givet,  åbner Action 8 Save as (Genvej: shiftzS PC: shift Ctrl S).
Gem billedet som ”opgavenummer-filnummer”
Eksempelvis: 123456-0123 hvor 123456 er det sekscifrede nummer fra fotobestillingen og
0123 er fra filnavnet DSC_0123.jpg, som Nikon D1 genererede. Det er meget vigtigt, at
opgavenummeret indtastes korrekt, idet det er et hovedelement i arkiveringssystemet.
Billedet gemmes i JPEG kvalitet 8 baseline. Hvis billedet ikke er optaget i RAW, TIFF eller
JPEG-Fine, skal det gemmes i kvalitet 10. Hvis billedet - uanset optageformat  - hurtigt
skal sendes over GSM, kan kvalitet ned til 2 undtagelsesvis vælges. Her er det vigtigt, at
du også gemmer en kvalitet 8 kopi, som kan lægges ind i FotoStation, så snart du kommer
forbi Fyns Amts Avis igen.

Hvis du ikke ønsker et digitalt vandmærke i dit billede, kan du blot springe Action 8 over og
åbne Save As manuelt i File > Save As (Genvej: shiftzS PC: shift Ctrl S).

9: Sort kant: Denne action giver automatisk billedet en sort udtonet ramme, der ligner en
sort kant fra de gamle S/H dage i mørkekammeret. Kontrollér inden Actionen
anvendes, at forgrund/baggrund farverne i værktøjskassen er indstillet rigtigt.
Forgrunden skal være hvid og baggrunden sort. Dobbeltklik på et af felterne
for at justere farven, hvis det er nødvendigt.
Den sorte kant bliver lavet på et fast mål, der svarer til størrelsen på et
ubeskåret, D1 billede i bredformat. Derfor kan den kun gives på ubeskårne bredformat
billeder, helt i overensstemmelse med god foto-etik.
Sort kant Actionen er en temmelig stor beregningsopgave for computeren. På en
PowerBook G3 tager processen ca. 50 sekunder. Billedets filstørrelse øges med ca. 500k.

Avanceret Photoshop 5.0

Gør-det-selv Actions. Det er nemt at lave sine
egne Actions. De fleste handlinger i Photoshop
han optages som Actions: Start med at åbne et
billede, der gerne må øgelægges. Klik med
musen på den lille trekant til højre for fanebladet
Actions. Klik eventuelt på Button Mode for at
fjerne fluebenet, hvis der er et.
Klik på New Action… I vinduet New Action, der
kommer frem, kan du navngive den nye Action.
Du kan også tildele den en farve og en F-taste.
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Tryk derefter på Record-knappen. Nu optages de handlinger, du foretager dig. Du kan se,
at optagefunktionen er aktiv, idet den røde prik i bunden af Action-vinduet er trykket ned.

Et eksempel på en Action kan være at størrelsessætte billedet til udprintning på Epson-
printeren.

Når den handling, du ønsker at optage, er afsluttet, trykker du på den lille firkantede stop-
knap til venstre for knappen med den røde optage prik.

Vælg Button Mode igen og prøv at afspille din action.

Hvis Actionen blot skal åbne fx værktøjet Color Balance i Image  > Adjust , hvor du selv
skal indsætte værdier, skal du efter at have startet optagelsen trykke på Insert Menu
Item… knappen. Den findes i den lille trekant til højre for Actions-fanebladet.
I dialogen Insert Menu Item, der kommer frem, skriver du navnet på det værktøj, du vil
åbne, altså i dette eksempel Color Balance.

Actions kan i øvrigt nemt udveksles mellem flere computere over fx Internettet.

History funktionen findes i fanebladet til venstre for Actions (Window > Show History).
Alle ændringer i billedet registreres som et lag i History oversigten.
Det lag, billedet befinder sig i lige nu, er markeret. Ved at klikke på et af de andre lag, kan
man se billedet, som det så ud på netop det trin i billedbehandlingen.
Lagene kan fjernes enkeltvist nedefra ved at trække dem ind i den lille skraldespand i
bunden af History-vinduet. På den måde er det muligt at slette handlinger langt tilbage i
billedbehandlingsprocessen. Eksempelvis gennemfører  Actionen ”Sort Kant” otte
handlinger. Hvis man vil fortryde den sorte kant, kan det ikke gøres med fortryd funktionen
zZ PC: Ctrl Z . Man bliver nødt til at fjerne handlingerne én efter én fra History.

History Brush
Et nyt fikst værktøj i Photoshop 5 er History Brush,
som vælges fra Photoshops værktøjskasse

(Genvej: Y).

History brush udnytter History-funktionen: Med History
Brush kan du nu male ét history lag ind i et andet lag med
en selvvalgt brush (Window > Show Brushes).

Fx har du muligheden for at male en højlys-detalje på
igen, der er gået tabt under billedbehandlingen, fra det
oprindelige ubehandlede billede.
Det gøres ved at klikke History Brush på i det tomme felt
til venstre for det lag i History, man nu ønsker at male fra.
Derefter maler man så direkte på billedet med det
oprindelige lag.
I eksemplet til højre, har jeg malet himlen tilbage på et
billede. Den gik tabt i Curves, og bliver malet fra Rotate
Canvas laget ind på det nyeste lag (Band Aide).
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Partiel støjfjerning er et andet oplagt sted at bruge History Brush. Her kan man male med
det lidt uskarpe, støjrensede billede i de mørke, støjfyldte partier af billedet. På den måde
bliver støjen mindre fremtrædende.

History Brush er også meget effektiv til, sammen med filteret Dust And Scratches, at fjerne
ridser og støv fra indscannede negativer.

Sort/Hvid
Her er fire måder at lave sort/hvide billeder digitalt:

I kameraet: Nikon D1 laver fremragende sort/hvide billeder i kameraet. Ved at dreje sub-
command hjulet mens image quality-knappen under dækslet er trykket ind, kan der vælges
B/W i alle optageformater undtagen RAW. Billeder, der er optaget på denne måde, har
samme filstørrelse som farvebillederne.

Photoshop Grayscale: Den nemmeste måde at konvertere et farvebillede til sort/hvid er i
Photoshops Grayscale-mode: Image > Mode > Grayscale. Billedet kan herefter behandles
i fx Levels eller Curves. Filstørrelsen reduceres til 1/3 af farvebilledets.

Photoshop Channel Mixer: Channel Mixer
giver væsentligt flottere s/h billeder end
Grayscale.
I Channel Mixer (Image > Adjust > Chanel
Mixer kryds i Monochrome). Ved at ændre
balancen mellem farverne kan du arbejde
med billedet på samme måde, som hvis det
var optaget på s/h film med et farvet filter
foran objektivet. Som udgangspunkt bør
summen af værdierne være 100.. Lasso
værktøjet kan bruges. Billeder optaget i B/W
mode i Nikon D1 kan også behandles i
Channel Mixer. Filstørrelsen er den samme
som farvebilledet.

Photoshop Hue/Saturation: I Hue/Saturation (Genvej: zU PC: Ctrl U) indstilles Edit til
Master og Saturations værdien stilles til minus 100. Ved nu at ændre Hue, Saturation og
Lightness værdierne for de farver, der kan vælges i Edit, ændres billedet på samme måde
som i Channel Mixer metoden beskrevet ovenfor.

Husk at konvertere billedet til Grayscale (Image > Mode > Grayscale) efter afsluttet S/H
behandling. Derved reduceres filstørrelsen til en tredjedel.

Fjern digital støj med Quantum Mechanics Pro og Band Aide
Digital støj er altid til stede i digitale billeder. Den bliver først synlig, når kameraets ISO-
værdi presses op og når mørke billeder gøres lysere i billedbehandlingen. Alle Nikon D1
billeder optaget på ISO 800 eller højere har synlig digital støj.

Den digitale støj antager typisk to former, der hver især skal fjernes med et bestemt filter:
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Crominans støj optræder som små blå og røde prikker overalt i billedet. Crominans støj
kan meget let fjernes med Quantum Mechanics Pro (QM).
Banding viser sig som striber på billedets længste led. Støjen kan dæmpes meget med
Band Aide filteret.
På side 31 findes eksempler på, hvordan de to typer støj kan se ud.
Et billede kan indeholde begge typer støj. Erfaringsmæssigt er det bedst at fjerne
crominansstøjen først.
Begge filtre er meget brugervenlige med et stort preview vindue.
Når cursoren føres hen over preview vinduet bliver den til en flyttehånd, der kan flytte
preview feltet rundt i billedet. Så længe museknappen holdes nede, ses billedet før
filtreringen. Når knappen slippes ses billedet efter filtreringen. På den måde kan man hele
tiden vurdere effekten af filteret.
Begge filtre virker også partielt fx indenfor en lasso-afgrænsning.

Quantum Mechanics Pro åbnes fra Actionpaletten.
Auto Contrast Range er en slags Auto-levels og bør slås fra.
Filter Amount kan fintune virkningen af filtret. Bør stå på 100%
Filter Mode stilles i Quick Filtering.

Med Radius skydeknapperne i Red Chrominance og Blue Chrominance felterne stilles
filterets effekt på de røde og blå prikker. Det er lidt nemmere at se, hvad man laver, hvis
Preview stilles, så den matcher den skydeknap, man arbejder med, fx Blue Chrome, når
der arbejdes med radius skyderen i Blue Chrominance.
Despeckle Luminance forebygger hvide prikker i billedet, når det senere får Unsharp
Mask. Slå funktionen fra, indtil du ser effekten af din Unsharp Mask.
Sharpening er en mulighed for at give billedet Unsharp Mask. Funktionen bør slås fra,
idet den gør det umuligt for Band Aide filteret at virke ordentligt. Slås fra ved at sætte
Radius til off.
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Band Aide åbnes også fra Actionpaletten.
Auto Contrast Range slås også fra her.
Filter Amount svækker effekten af den filterstyrke, der er valgt i Filter Strength. Filter
Amount er mere følsom i den lave ende af procent-skalaen.

Støjen i et 800 ISO billede kan sædvanligvis fjernes med omtrent den indstilling, der er sat
i ovenstående illustration.

Band Aide filteret mindsker ”banding” støjen på bekostning af skarpheden. Men det
problem kan ikke altid løses ved at give noget mere Unsharp Mask.
Det er vigtigt at være opmærksom på, hvad der sker med billedet når Unsharp Mask gives.
Der kan bl.a. optræde hvide prikker spredt rundt i billedet. De kan ofte fjernes ved at
fortryde hele Band Aide og QM i History, og starte forfra med kryds i QM-boksen
Despeckle Luminance.
Hvis prikkerne ikke forsvinder, må man simpelthen leve med at billedet er en smule
uskarpt.
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Sammenkopiér billeder
I forbindelse med fx udprintning af billeder på Epson printeren, kan det være en fordel at
lave en billedmosaik, så to eller flere billeder kan køres ud på ét ark papir:
• Åben de billeder, du ønsker at kopiere ind på samme canvas.
• Størrelsessæt billederne (Image > Image Size…) og rotér dem eventuelt, så de passer

i den mosaik, du ønsker.
• Canvasstørrelsen ændres (Image > Canvas Size) på ét af billederne, så de øvrige

senere kan kopieres ind på.
• Vælg Move Tool (Genvej: V) og flyt ved hjælp af musen det første billede hen på sin

plads.
• Træk nu ved hjælp af musen og Move Tool (Genvej: V) de øvrige billeder ind på deres

respektive pladser i de ledige dele af det første billedes canvas.

Vær opmærksom på, at det foregående billede ikke umiddelbart lader sig flytte (efter at du
er begyndt at flytte det næste billede).

Panoramabilleder
Sammenkopieringsteknikken kan også bruges til at skabe panoramabilleder med. Det er
hensigtsmæssigt, at alle billeder i panorama mosaikken er eksponeret ens. Det betyder i
den digitale verden, at eksponeringen skal være manuel, hvidbalancen på en fast værdi
(ikke A) og at tonekurven skal være fast (ikke CF-24-0). Billederne bør optages med en
50mm eller derover. Så bliver perspektiv forskellene i de områder, hvor enkeltbillederne
skal sættes sammen minimale.

Pre Press
Mål på billederne
Ved hjælp af Info vinduet (Windows > Show Info) kan du måle
bl.a. hvor meget sort, der er i billedet. Dette kaldes K-værdien, og
må ikke forveksles med K i CMYK.
Alle dele af billedet, der måler mindre end 6-7 (K), bliver gengivet
hvidt i avisen. Alle dele af billedet, der måler mere end 92-93 (K),
vil blive gengivet sort.
Hvis et lyst område i billedet, fx en skjorte, måler mellem 5 og 12 (K) afhængigt af hvor,
der måles, betyder det, at den vil blive gengivet med lidt struktur. Måler den derimod
mellem 0 og 6 (K), vil den blive gengivet som en helt hvid flade.

Blege nordeuropæiske mennesker bør erfaringsmæssigt måle mellem 15 og 40 K i de
lysere dele ansigtet.
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RGB til CMYK teori
Optagelsen og behandlingen af digitale billeder foregår fra fotografens side i RGB-farver.
Inden billedet trykkes i avisen,  konverteres det automatisk til CMYK-farver. I den
forbindelse kan der ske ændringer af farverne i billedet. Forklaring følger her:

Omfanget (engelsk: gamut) af de farver menneskets øje kan opfatte, kan beskrives ved
CIE LAB 1931 figuren herunder:

Den krumme kurve fra violet (380 nm) over blå, cyan, grøn og gul til rød (680 nm) dækker
alle de farver, der findes i solspektret. Kurven fra violet over magenta til rød dækker de
farver, der ikke findes i solspektret.
Farverne langs kanten af kurverne er helt mættede, og blandes til hvid inde i centrum af
figuren.

Kilde: efg’s Computer Lab http://www.efg2.com/lab
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En RGB-monitor skaber farver ved at blande rødt, grønt og blåt lys. Den kan derfor kun
vise de farver, der findes (i rummet) mellem disse tre farver. Den indtegnede RGB-trekant
viser princippet i RGB farve gamut, der i øvrigt kan variere fra monitor til monitor.

Ved CMYK-tryk dannes farverne ved at blande cyan, magenta og gule trykfarver. Det
farveomfang, der kan gengives af disse farver, er skitseret med CMYK-trekanten inde i
LAB figuren. CMYK-gamut varierer fra trykkeri til trykkeri og afhænger bl.a. af trykfarver,
papirkvalitet og de arbejdsrutiner, trykkeriet har.

De farver indenfor RGB-gamut, der befinder sig udenfor CMYK-gamut siges i Photoshop
terminologi at være Out of Gamut – altså udenfor CMYK-farvernes gamut.
Disse farver kan ikke trykkes præcist, som de ses på RGB-monitoren. Det drejer sig især
om meget mættede blå, grønne og røde farver.

Ved konvertering af billedet fra RGB til CMYK bliver de dele af billedet, der er out of
gamut, klemt proportionalt sammen indenfor CMYK-gamut.

I praksis betyder det, at det ikke er alle farver, som ses på monitoren, der kan trykkes i
avisen; WYS er ikke altid WYG.

Valg af colorspace: I forbindelse med overgangen til digital fotografering har Fyns Amts
Avis valgt at indføre Adobe RGB som standard farverum på alle computere, der arbejder
med billeder. Adobe RGB har et større gamut end det, der kan vises på en RGB monitor.
Det betyder at visse farver, der ligger udenfor monitorens gamut, kan måles og trykkes,
men ikke ses på monitoren.

Gamut Warning
Gamut Warning er et hjælpeværktøj i Photoshop, der kan vise, hvilke farver i RGB billedet,
der ligger udenfor CMYK-gamut. Tryk zshiftY PC: Ctrl Shift Y og de kritiske farver
markeres med grå. Gamut Warning skal behandles lidt på samme måde som Highlights
advarslen på Nikon D1. Det er kun, hvis farveproblemet er relevant for biledet, at man skal
begynde at gøre noget ved det.

CMYK Preview: I CMYK preview (Genvej zY PC: Ctrl Y) i Photoshop kan du få et indtryk
af, hvordan billedet vil blive gengivet i avisen. Det kan anbefales, at bruge CMYK Preview
sammen med Gamut Warning for på den måde at se omfanget af de farveskift , som
Gamut Warning advarer om.

Info: Infopaletten kan bl.a. også indstilles til at vise CMYK
værdier. I eksemplet til højre, er alle farverne out of Gamut.
Det markeret med udråbstegnene yderst til højre.
Infopalettens målemetode ændres ved at trykke på den lille
pipette. Bemærk at de K-værdier, der er omtalt i afsnittet
”Mål på billederne” er Grayscale K og ikke CMY –K.
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Arkivering
Billedarkivering er en meget vigtig del af hele den digitale billedproces. Hvis billedet ikke er
arkiveret forskriftsmæssigt, er det vanskeligt at finde igen. Til gengæld vil hele Fyns Amts
Avis få glæde af et velfungerende elektronisk arkiv.

Arkivet søger på den tekst, der er vedhæftet billedet. Det er derfor vigtigt, at kvaliteten af
teksten er så god som mulig.
Teksten skal indskrives i File Info i Photoshop og består af:

• Opgavenummeret, der findes på fotobestillingssedlen. Dette nummer sørger for at de
informationer, der findes i fotobestillingen overføres til billedet.

• Fotografens egen tekst. Til hvert billede skriver fotografen en faktuel tekst med
oplysninger fx hvem, hvad, hvor osv.

• Keywords: Fotografen kan vælge at forsyne billedet med et eller flere keywords.
Der må kun anvendes keywords, der findes på keyword listen i appendix 6.

Selve den fysiske arkivering foregår i øjeblikket på en server. Hvordan billederne i
fremtiden skal gemmes, er der endnu ikke taget stilling til.

Fotografernes egenarkivering
For din egen skyld, vil jeg foreslå, at du selv laver en kopi af dine billeder, som du tager
med hjem.
Jeg brænder fx hver uge en CD-ROM med alle ugens rå og behandlede billeder. Det
passer stort set altid med, at en hel uges produktion kan lagres på én CD.

Sådan brænder du en CD-ROM
Denne vejledning gælder for Fotoafdelingens LaCie CD-ROM brænder tilsluttet en Mac.
Saml de filer du ønsker at brænde i en mappe. Husk, at der på hver CD kan gemmes 650
MB data.
Mappen skal befinde sig på den samme computer, som brænderen er tilsluttet.

• Tilslut fotoafdelingens CD-ROM brænder til din Powerbook via USB stikket.
• Åben nu programmet Adaptec Toast fra Kvikstart.
• Hvis du senere ønsker at kunne læse CD-ROM’en fra en PC, skal du huske at brænde

den i ISO 9660 formatet. Det vælger du i Format > flueben ved ISO 9660 (Genvej z3),
inden du brænder.

• Klik på Data og træk de emner der skal kopieres ind i feltet i midten af vinduet.
• Tryk Done.
• Indsæt en blank brændbar CD-ROM i det eksterne CD-ROM drev.
• Tryk på Write CD > vælg 4x > tryk på Write Disc. Herefter går skrivningen i gang. Det

kan vare op til 20 minutter. Herefter laver programmet en kort pause, hvorefter det
kontrollerer brændingen (verifying). Dette tager også op til 20 minutter.

• Herefter meddeler programmet ”Verification completed successfully”, hvis alt gik vel.
Tryk på Eject og fjern din CD fra drevet.

• Fjern evt. dit materiale fra data ( Data > markér data > remove > Done).
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Fotobestilling
Alle billeder, der skal arkiveres, skal forsynes med et individuelt identifikationsnummer. Det
består af et sekscifret nummer, der automatisk bliver genereret i fotobestillingen, plus det
filnummer, som Nikon D1 giver den enkelte billedfil. De to numre skal adskilles af en
bindestreg ”-”.
I de tilfælde, hvor der ikke er blevet lavet en fotobestilling , fx  ulykker, initiativbilleder og
lignende, skal fotografen selv skrive en fotobestilling.

Fotobestillingsblanketten herover findes på Fyns Amts Avis’ interne intranet ved at indtaste
adressen http://fotoweb.faa.dk  i din webbrowser.
Der skal ikke gøres noget stort nummer ud af at udfylde bestillingen. Det vigtigste er at få
tildelt et identifikstionsnummer.
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Epson printer
Epson Photo Stylus 1200 printeren giver mulighed for at lave inkjet print i næsten
fotografisk kvalitet.
Printeren skal tilsluttes den bærbare computer via USB-stikket.
Derefter skal printeren vælges i ”Vælger” ( Æblemenu > Vælger > markér SP 1200).

Billedet, der skal udskrives, kan fx åbnes i Photoshop og størrelsessættes. Dette gøres i
Image > Image Size. Det kan anbefales at sætte resolution til 300 pixels/inch. Hvis billedet
skal gøres større end den valgte resolution tillader, bør billedet resamples i bicubic.

I Page setup (File > Page setup, genvej ShiftzP) sættes papirstørrelse (standard er A5)
og papirretning. Et kryds i Caption betyder, at teksten fra File Info udskrives under billedet.
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Print ved at vælge File > Print (genvej zP). Nedenstående printer vindue kommer frem.
Her kan du kontrollere, at alt er i orden, inden printeren sættes i gang.

I ovenstående vindue er ”Custom” funktionen valgt. Her er det muligt at indstille printeren
optimalt. Vinduet viser mit, indtil videre, bedste bud på en printerindstilling.
Ved at trykke på Advanced kan man indstille printer parametre som skarphed og
opløsning. Indstillingerne kan gemmes, så de nemt kan aktiveres igen. Mine indstillinger
hedder i eksemplet ovenfor ”Digitalfoto”.

Blækket i Epson printerens meget små blækdyser størkner meget let, hvis printeren fx
udsættes for træk. Derfor er det vigtigt at holde den tildækket, når den ikke bruges.

Almindelig vedligeholdelse af printeren, fx skift af blækpatroner, finjustering og rensning af
dyserne, er beskrevet i printerens manual.

Der kan være problemer med, at computer og printer ikke vil kendes ved hinanden.
Problemet er beskrevet i Appendix 2.
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Appendix 1

Her kan du finde yderligere information
http://www.robgalbraith.com Canadisk pressefotograf og digital pionér. Siden har
nyheder og tests af nyt digitalt isenkram. En seriøs side på et højt fagligt niveau og
samtidig let læselig. Den indeholder nyheder og et glimrende forum. Rob Galbraith har
udgivet et håndbog i digital pressefotografering, som Fyns Amts Avis har støttet sig til i
planlægningen af det digitale fotoprojekt.

http://www.henrikbo.dk er pressefotograf Henrik Bos hjemmeside. Han er digital
superbruger på Nordjyske Stiftstidende. Nordjyske er dansk pionér på digital
pressefotografering, og har været en vigtig inspriationskilde i arbejdet med digital
pressefotografering på Fyns Amts Avis.

http://www.nikon-euro.com/nikoneuro_en/hit/dc/dcd1/en/HIT_dcd1_en_0.htm er
Nikon Europas officielle side med tips og ideer til Nikon D1.

http://www.nikontechusa.com/supportframe.htm er Nikon USA's officielle support
forum. Kræver en registrering (kan udføres on-line) og at man opgiver serienummeret på
sin Nikon D1.

http://www.peimag.com/ Professionelt digitalt forum.

http://photo.askey.net Digitale nyheder og fora. Pro Digital Talk er et godt sted at kigge
efter Nikon D1 diskussioner

http://www.imaging-resource.com/NEWS.HTM Digitale nyheder.

http://www.manginphotography.com/sptshtr.html Sports Shooter er et amerikansk
magasin for professionelle sportsfotografer. Gode artikler om digitale erfaringer.

http://www.digitaldog.net/tips.html beskæftiger sig med Photoshop og prepress emner
som bl.a. farvestyring.

http://www.camerabits.com Udvikler af bl.a. Quantum Mechanics Pro og Band Aide filter
plug-ins til Photoshop.

http://www.charm.net/~mchaney/imaging Q-Image tilbyder bl.a. interpoleringssoftware
og støjfiltre til Nikon D1. Kun til PC. Har udviklet Band Aide i samarbejde med Camera Bits

http://home.austin.rr.com/goce/bibble/bibble.htm Eric Hyman har udviklet Bibble og
MacBibble programerne, der kan læse Nikon D1 RAW filer. Programmmerne kan lave
eksponeringskorrektion på RAW.filer efter eksponeringen. MacBibble er i skrivende stund i
udviklingsfasen. Der kan downloades en gratis beta-version.

http://www.mindspring.com/~x11r6.1/ Her kan Nikon D1 RAW-fil læseren C-Image til
PC downloades.
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Appendix 2
Tips og løsninger af kendte problemer

Genveje i Photoshop 5.0.2:
Åbn Curves: zM (PC: Ctrlt M)
Åbn Levels: zL (PC: Ctrlt L)
Åbn Hue/Saturation: zU (PC: Ctrl U)

Gamut Warning: zShiftY (PC: shif Ctrlt M)
CMYK preview: zY (PC: Ctrk Y)
Save: zS (PC: Ctrl S)   Save As: Shift zS (PC: shift Ctrl S)

Fjern/genskab værktøj: Tabulator tasten
Undo (Fortryd sidste handling): zZ (PC: Ctrl Z)
Afslut billedet: zW (PC: Ctrl W)

Luk Photoshop: zQ (PC: Ctrl Q)

.
Genveje til værktøj i paletten:
Zoom: Z (Hold  Alt tasten nede for at skifte mellem zoom + og -)
Stamp: S (Kloneværktøjet)
Lasso: L

History Brush: Y
Burn/Dodge: O
Flytte-hånd: H eller mellemrumstangenten holdes nede. (Det værktøj du forlod kommer
igen, når du slipper mellemrumstangenten.)

Eye-dropper: I

Øvrige:
Inverse: Shift+zI  (PC: shift Ctrl I) (Bruges fx når alt andet end det, der er markeret med
lassoen skal gøres aktivt.)

Brug Feather 50 i Lasso

Svampe-værktøjet i Burn/Dodge bruges til at ændre mætningen i den del af billedet, du
anvender det på. Vælg Saturate for højere mætning og Desaturate for lavere mætning.
Værktøjets størrelse vælges også her i Brushes.

Hvor der er flere værktøjer i samme palet-ikon, kan du rulle i de forskellige værktøjer ved
at trykke på tasten en gang til mens Shift tasten holdes nede.
Fx i Lasso, hvor du med L-tasten kan skifte mellem Frihånds lasso, Polygon lasso og
Magnetisk lasso.



Genveje i Mac OS9
Genopbyg skrivebord: Hold z og Alt tasterne nede mens maskinen starter. Dette bør
gøres mindst en gang om ugen, hvis man ønsker en stabil maskine.

Vælg alt: zA
Kopiér: zC
Sæt ind: zV

Ny mappe: (klik på skrivebordet først) zN
Luk vindue: zW
Afslut: zQ

Nødafbryder: Alt zStartknap (kun hvis computeren er håbløst frosset fast!

Arkivoversættelse
Når man dobbeltklikker på et billedikon, åbner computeren automatisk billedet med det
billedprogram, man på forhånd har valgt skal gøre det. Fra fabrikken er Macintosh
computere indstillet til at åbne billedfiler i programmet Quick Time. Windows computere
åbner som standard billedfiler i Microsoft Photo Editor. Disse indstillinger kan du selv
ændre. Det er fx hensigtsmæssigt for vores brug, at billedfiler automatisk åbner i
Photoshop 5.0. Hvis du vil bruge MacBibble/Bibble, kan du indstille arkivoversættelses
funktionerne til at åbne  .nef filer i dette program.

I en Macintosh computer med OS9 kaldes dette arkivudveksling. Denne funktion findes i
Æble-menu > Kontrolpaneler > Arkivudveksling. I fanebladet Referencer kan du se, hvilket
program, der åbner hvilke filtyper. Markér den filtype, du ønsker at ændre arkivudvekslings
egenskaberne for, tryk på Skift knappen. Nu kan du vælge et andet program, der skal
åbne den pågældende filtype.

I en Windows 9x computer ændres indstillingerne i Denne Computer > Vis >
Mappeindstillinger > Faneblad Filtyper. Markér fx ”JPEG-billede” og tryk Redigér.
I vinduet ”Redigeringshandling for typen : JPEG-billede” trykker du Gennemse og finder
der stien til Photoshop. Den findes sandsynligvis i  C > Programmer > Adobe > Photoshop
> Photoshop.

Alle fotoafdelingens Macintosh computere – undtagen fotoafdelingens G4, er indstillet til at
åbne billedfiler af JPEG og TIFF typen i Photoshop 5.

Filter-flash ved lysstorfør
Følgende anbefalinger angiver de Kodak Color Correction filtre, der kan sættes foran
flashen,således at flashen giver samme farve som det omgivende lys. Hele farvestikket
filtreres derefter ved hjælp af kameraets hvidbalance.

Rørtypen er oftest angivet på selve lysstofrøret. Hvis det ikke er muligt at aflæse rørtypen
kan filtreringen  CC10R+CC20G (”ukendt rørtype”) bruges.
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Rørtype CC filter

Daylight: CC 40 G + CC 40 B

White: CC 20 R + CC 30 G

Warm White: CC 40 R + CC 40 G

Warm White de Luxe: CC 60 R + CC 30 G

Cool White: CC 30 G

Cool White de Luxe: CC 20 R + CC 10 G

Ukendt lysstofrør: CC 10 R + CC 20 G

Glødelampe (100W) 85 B

Der er dog ingen grund til at være hysterisk med en helt eksakt filtrering; meget kan
reddes i Photoshop bagefter. Jeg bruger selv kun 10R+20G og 85B.

Finjustering af hvidbalancen i Nikon D1
Følgende tabel viser farvetemperaturskiftet i Kelvin grader, når Nikon D1s seks faste
hvidbalance indstillinger justeres manuelt med sub-command hjulet ved pegefingeren.

Kamera Display--> -3 -2 -1 0 1 2 3

Direct Sunlight 460 300 140 0 -120 -260 -360
Shade 820 520 240 0 -240 -460 -680
Overcast 580 360 180 0 -180 -360 -500
Incandescent 300 200 100 0 -80 -160 -240
Fluorescent 280 180 100 0 -80 -160 -240
Flash 600 400 200 0 -200 -400 -600

Kilde: http://www.nikon-euro.com/

Kendte Compact-Flash kort problemer
LCD-monitoren skriver ”Card contains no images” selvom der tilsyneladende må være
billeder på CompactFlash kortet (idet Top-LCD displayet fx viser 52 billeder tilbage på et
160 MB kort).
Fænomenet opstår, når CompactFlash kortet ikke er blevet formateret i kameraet efter at
billedfilerne på CompactFlash kortet enten er blevet slettet i en Apple Macintosh,
eller blot trukket ud på skrivebordet uden at være blevet gemt i fx en mappe.
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Løsningen er at formatere CompactFlash kortet i kameraet og huske altid at kopiere
billedfilerne direkte til fx en mappe i computeren inden CompactFlash kortet fjernes fra
den.

Nikon D1 er blevet længere tid om at skrive til CompactFlash kortet: Løsning:
CompactFlash kortet skal engang imellem fuld-formateres. Den formatering, der sker i
Nikon D1 er en hurtigformatering. En fuld formatering kan kun foretages i en PC. Hvis du
råder over en Windows PC med enten en PC-kort læser, CF-kortlæser eller et USB-stik
kan du selv foretage en fuld formatering.

Hvis ikke vil jeg gerne hjælpe dig

Epson PhotoStylus 1200+ udskriver ikke: Undersøg først de gængse problemer i
Epsons egen instruktionsbog. Hvis dette ikke løser problemet, kan det skyldes en kendt
fejl i forbindelse med USB:
Når Epson printeren vælges i Vælger, kommer der muligvis ikke nogen port frem i højre
del af Vælger-vinduet. Det kan skyldes, at der er sat et forkert kryds i Kontrolpaneler >
Udvidelseskontrol. Der må kun være kryds i én af de bokse, der hedder noget med Epson
USB ntclassx.

La Cie CD-ROM brænderen kan
ikke findes, selvom den er tændt
og tilsluttet. Prøv først at slukke
og tænde CD-ROM brænderen.
Der kan også være konflikt
mellem Logitechmusen og La Cie
CD-rom brænderen. De bruge
begge to USM-porten. Problemet
løses midlertidigt, ved at fjerne
Logitech musen fra USB stikket,
genstarte CD-ROM brænderen
og trykke på Search knappen i
Toast vinduet.
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Appendix 3

Opsætning og indstillinger i Nikon D1 Firmware Nr. 1.0.5
Standardindstillinger for delekameraer

CF-
nr. Standardindstilling

Må
ændres
?

CF-nr. Standardindstilling
Må
ændres
?

0 A B ja 0 A B ja

1 0 0 ja 18 0 0 ja

2 3 3 ja 19 0 0 ja

3 0 0 ja 20 0 0 ja

4 0 1 ja 21 0 0 ja

5 0 0 ja 22 0 0 ja

6 0 0 ja 23 3 3 nej

7 0 0 ja 24 0 0 ja

8 0 0 ja 25 ch ch ja

9 0 0 ja 26 21 21 ja

10 0 0 ja 27 2 2 ja

11 as as ja 28 1 1 ja

12 0 0 ja 29 1 1 ja

13 0 0 ja 30 s s ja

14 8 8 ja 31 0 0 ja

15 6 6 ja

16 10 10 ja

17 0 0 ja

Når delekameraet returneres, er det lånerens ansvar, at alle CF-funktioner stilles i som
ovenstående, at CompactFlash kortet er formateret og alle batterier er ladet helt op.
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Appendix 4
Opsætning af computer
Apple Powerbook G3
Modelspecifikationer: Powerbook G3 Lombard 333 Mhz, 4 GB Harddisk, 320 MB RAM

Powerbook G3 Pismo  400 Mhz, 5,5 GB Harddisk, 320 MB RAM
Styresystem: Mac OS9
Arkivoversættelse: Alle JPEG og TIFF filer åbnes af Adobe Photoshop 5.0.2
Skrivebordsfarver: Stribet baggrund 3
MouseWare: fra Logitech installeret

Opsætning af hovedprogrammerne:
Adobe Photoshop 5.0.2
Filesaving:
File > Preferences > Saving Files: x Never Save

x Always (for at undgå thumbnail
x Use lower Case
Blank Include …

Color Space: Adobe RGB

Plug Ins: Quantum Mechanics Pro, Band Aide og Nikon YCC format læser

FotoStation 4.0 build 85
Alle udmapper på nær én er fjernet. Sidste mappe er omdøbt til Udvalg,
farvet grøn, og henviser til en grøn Udvalg-mappe på skrivebordet.

Fetch 3.0.3
Customize > Preferences > Faneblad Misc: Fjern kryds fra Anarchie emulation mode
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Appendix 5
Internetopsætning af Powerbook G3

Internet kan bruges via 3 telefon-/netværksforbindelser:

A. Alm. telefon (Tilsluttes via et normalt telefonstik)
B. Mobiltelefon (Via mobiltelefon)
C. Fyns Amts Avis Sct. Nicolaigade (Tilsluttes via Netværket på FAA)

Fremgangsmåde:

1. Klik på "TCP/IP" i Kvikstart under "Internet-/netværksforbindelse" i Kvikstart
2. Tast zK
3. Marker den forbindelse du ønsker at bruge (A, B eller C)
4. Klik på knappen "Aktiver"
5. Luk vinduet "TCP/IP (.......)" i lukkefirkant i venstre hjørne eller tast z W

                          Brug din egen IP adresse i stedet for den, der står  i illustrationen herover
6. Klik på "Modem" i Kvikstart under "Internet-/netværksforbindelse"
7. Tast z K
8. Marker den forbindelse du ønsker at bruge (A, B eller C)
9. Klik på knappen "Aktiver"
10. Luk vinduet "Modem (........)" i lukkefirkant i venstre hjørne eller tast zW
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11. Klik på "Remote Access" i Kvikstart under "Internet-/netværksforbindelse"
12. Tast zK
13. Marker den forbindelse du ønsker at bruge (A, B eller C)
14. Luk vinduet "Remote Access (..)" i lukkefirkant i venstre hjørne eller tast zW

                                       Indsæt dine egne adgangskoder i felterne Navn og Adgangskoder

Klik på "Netscape", ”Internet Explorer” eller "Fetch" i Kvikstart under "Programmer" og der
etableres automatisk en forbindelse til Internettet.

Tilslutning på lokalredaktion: Du kan også overføre billeder via Fyns Amts Avis’ netværk
på lokalredaktionerne. Du kan ikke gå på Internettet eller hente post via din egen computer
via netværket på en lokalredaktion.

Tilslut netværkskablet til din computer og netværksstikket. Vær opmærksom på, at
Langelandsredaktionen bruger samme type stik til både telefon og netværk. Vær helt
sikker på, at du bruger det rigtige stik.

Konfigurér computerens netværksforbindelse til ” Fyns Amts Avis Sct. Nicolaigade”
Undtagen TCP/IP indstillingen. Her vælges en af telefon-indstillingerne.

Billeder kan overføres til avisens billeddatabase ved at trække billedfil ikonerne hen i den
røde FAA-Fotografer henvisningsmappe.
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Tele Danmark opkaldsnumre
Fyns Amts Avis har valgt Tele Danmark Internet som Internetudbyder til fotografernes
billedtransmission. Dette giver mulighed for at kalde op til lokale opkoblingspunkter over
hele Verden. Det sparer penge hos den du låner telefonen af. Nedenstående liste er et
udvalg af telefonnumre. Jeg har derudover en liste på 4.500 opkaldspunkter i 85 lande.

Fyn:
Assens: 6371 1900
Bogense: 6381 1900
Fåborg: 6361 6900

Middelfart: 6341 1900
Nyborg: 6331 3900
Rudkøbing: 6351 1900

Odense: 6313 0170
Svendborg: 6321 0086
Ærøskøbing: 6352 1900

Mobiltelefon:
Mobiltelefon: 8725 6902 *

Øvrige Danmark:
Albertslund: 4366 1520
Esbjerg: 7610 2800
Frederiksberg: 3816 1737

Frederikshavn: 9622 2198
Frederikssund: 4736 1277

Haderslev: 7323 0999
Herning: 9626 2900
Hjørring: 9623 1898

Kolding: 7630 5800
Nakskov: 5491 1058
Næstved: 5575 1521

Randers: 8710 1098
Rønne: 5694 1058
Thisted: 9617 2698

Viborg: 8725 6900
Århus: 8731 1111
Aalborg: 9630 4900

Opkald i Udlandet
Bahamas: 242 356 1118
Norge: 7350 3800
Sverige: 3-cifret område nr. + 559997

Tyskland (GSM): 0171 22265
Tyskland (fastnet): 01024 01924 777

*Dette nummer skulle også virke ved opkald fra udlandet, det er dog endnu ikke blevet
afprøvet i praksis!

For at bruge et telefonnummer fra listen, skal det du rette i telefonnummeret der kommer
frem i  Remote Access vinduet når du konfigurere din telefon/netværksforbindelse.
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Appendix 6

Fyns Amts Avis keywords
Arbejdsmarkedet
Arkitektur
Byggeri
Bygninger
Erhverv
Festligheder
Film
Fodbold
Foreninger
Forvaltninger
Fritid
Geografi
Gymnastik
Handel
Historie
Håndbold
Håndværk
Industri
Kommunikation
Kultur
Kunst
Landbrug
Litteratur
Millitærvæsen
Musik
Natur
Portrætter
Politi
Politik
Religion
Restauranter
Retsvæsen
Samfundsforhold
Sejlsport
Sport
Sygdom og sundhed
Teater
Trafik
Turisme
Uddannelse
Ulykker
Undervisning
Vejanlæg
Videnskab
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Appendix 7

Dine serie- og licens numre

Navn:

Nikon D1 serienr.

Powerbook serienr.

Powerbookens FAA-nr.

TCP/IP (IP adresse)

Photoshop 5.0.2

FotoStation 4 build 80

Quantum Mechanic Pro

TeleDanmark
brugernavn
TeleDanmark
adgangskode

Digimarc ID: PIN: 59 ID: 479889


